
GoLive CyberStudio 3 Tutorial Guide



In this tutorial guide, you will create several pages with text,
graphics, and links and upload them to your Web server. You will
also learn how to quickly import an existing Web site in
CyberStudio 3.

If you consider yourself a relative newcomer to Web publishing,
there are certain conventions you should be aware of as you get
started. This will help you avoid some common pitfalls when
designing your first Web site.

Even though you are working on a Macintosh, all files for the
web require a filename extension (i.e., a suffix consisting of a
period followed by one or more characters). DOS-based
machines can handle only up to eight characters in their names,
plus three more in their extension (for example: mypage.htm).
This filename format is preferable should you ever need to stage
your Web site for previewing on a local DOS-based machine.

Pages are usually: .html (otherwise .htm)
GIF images are usually: .gif

JPEG images are usually: .jpg

The standard image formats for the web are GIF and JPEG. 
• GIFs are typically used for line art. 
• JPEGs are typically used for photographs and other images
with more than 256 colors.

PICTs and TIFFs won't work on the web. All graphics need to be
at a resolution of 72 dots per inch. JPEGs need to be saved as
RGB (CMYK or Grayscale won't work). 

Most Web Servers are case sensitive to file names. Some webmas-
ters require that all file names be in lower case — check with
your’s before starting your site. If you use the browse or the
Point & Shoot method to make your links, then CyberStudio will
create the link with the same case as your file name. 

The Macintosh doesn't recognize that a filename has changed
when you change the case since on the Macintosh filenames
aren't case sensitive. CyberStudio includes a Preference setting so
that filename case changes can be made.
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The Web is more restrictive on the use of special characters in
file names than your Macintosh. Therefore, you can't use the
following in file names:
• forward slash ( / )
• more than one "dot" ( . ) — the only period has to be part of
the extension as in: index.html
• you can't use the hyphen ( - ) as the first character in a file
name. 

Furthermore, some webmasters ban the use of;
• empty spaces in file names (the underscore character ( _ ) is
often used instead)
• ampersands ( & )
• possibly other characters — check with your webmaster. 

Most Internet Service Providers (ISP) require you to name your
home page as: index.html. Please check this with your ISP. 

Webservers are usually configured to find a "default" page in a
directory without the need to type the whole URL. The webmas-
ter setting up the webserver decides what the "default" page
should be named. Some webmasters use "index.html" while oth-
ers use "default.html" or "home.html". You should consult your
webmaster (or the webmaster of your ISP) what naming conven-
tion is being used on your server.

Check with your Internet Service Provider or webmaster to see if
they have any restrictions on the structure of your Web site. A
few require a "Flat" structure where all the pages and media are
in one folder.

Font sizes on the web are controlled by the browser not by the
author. Some users will have their browser configured to display
text at 9 points and other users will have theirs configured to
display text as large as 14 or even 18 points.

• HTML size 3 means to display text at the size set in the brows-
er's preferences.
• HTML size 2 is one font size smaller than the size set in the
browser's preferences.
• HTML size 4 is one font size larger than the size set in the
browser's preferences.
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Most users probably have their browsers configured to display
text at 12 point Times. However, fonts on a Windows machine
are about one step larger than on the Macintosh.

Because of the uncertainty over the viewing font size, your page
must be designed to handle a range of font sizes. Internet
Explorer on the Macintosh provides the easiest way to proof your
pages at a variety of font sizes. It has a Font larger/smaller but-
ton in its Toolbar which will let you easily change font sizes. (In
Navigator, you have to change the default font size in the
Preferences.)

For further information including tips to deal with this issue,
please consult our FAQ Pages located at our Web site.

Images viewed on a Windows machine look darker than the
same image viewed on a Macintosh. This is due to a difference
in gamma settings — the difference is worse on older Window's
computers. There are several ways to simulate the Window's
settings on a Macintosh.

• Go into your Monitors control panel and set the gamma to
"Uncorrected".
• Download the GammaToggle FKEY. (Shareware by Roland
Gustafsson at:  http://www.acts.org/roland/thanks/
• Use Knoll Software's Gamma which is supplied with Adobe
Photoshop.

You may want to check out the PNG format (“Portable Network
Graphics”) — an emerging image standard which compensates
for Gamma variations across platforms.

Congratulations! Now that you are Web-savvy, you are ready to
begin working with GoLive CyberStudio 3.

If you are interested in an easy guide to
publishing on the World Wide Web, we can
recommend, “The Non-Designers Web
Book,” published by Peachpit Press.

ISBN 0-201-68859-X
List price: $29.95 U.S.

Pages: 288 pages
Authors: Robin Williams and John Tollett
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Now that you are ready to begin working with GoLive
CyberStudio for the first time, you need to equip yourself with
the special documents we’ve received permission to include
from Funny Garbage, Inc. — a top Web design company.

Please locate the GoLive CyberStudio Tutorial folder (included on
your CD or available from our Web site for downloading).

For now, you will be using the Web page assets (tutorial) folder.
Included inside this folder are various images.
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Once you have located the Web page assets folder, you may
launch the GoLive CyberStudio application. An empty document
will open in Layout View.

Along the top of this untitled window are tabs for GoLive
CyberStudio’s different modes.

Along the top of the window are tabs for GoLive CyberStudio’s
different modes:
• Layout Editor, where you enter content and design the layout
for your Web page
• Frame Editor, where you create and manage frame sets 
• HTML Source Editor, which contains the HTML that represents
your page and which you can examine and edit 
• HTML Outline Editor, which shows your HTML in a      
convenient outline whose sections you can expand or collapse
• WebObjects Declaration Editor (which isn’t present when you
choose the recommended basic installation) 
• Layout Preview, where you can view your finished page  
without the need to launch a Web browser application
• Frame Preview, where you can view your completed frames
and frame sets created in the Frame Editor.

You will primarily be working in CyberStudio’s Layout Editor
when designing your Web page.
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In addition to the main window, when you launch GoLive
CyberStudio, it opens the Palette window, which looks like this:

The Palette contains icons for the objects you can place on your
page. Click the Palette’s first tab (if it isn’t clicked already) to see
the Basic Tags objects. Here’s a key idea: You work with GoLive
CyberStudio by dragging objects from the Palette and dropping
them onto your page.

CyberStudio has a context-sensitive Inspector window that allows
you to quickly customize selected objects without the need to ref-
erence pulldown menus. Select the Inspector from the Window
menu (Cmd-1).

Click on the Page Icon

in the upper left 
corner. 

The Inspector’s name
changes to the Page
Inspector and looks
like this:

Here you will find
information about
your page — for 
example, its default
color for text and links.
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The Toolbar located above your page is also context sensitive,
similar to the Inspector window, and provides you with 
convenient button shortcuts for often-used features.

CyberStudio has a state-of-the-art Site Manager which features
transparent integration with the Macintosh Finder. When a File is
moved, renamed, or deleted in the Site Window, the actions hap-
pen simultaneously in the Finder.

CyberStudio will create a folder to contain your Web site. You will
place web-ready media assets such as images into this site folder.
As you create pages, you will store them inside this site folder.
Within the site folder you can create any subfolder structure that
meets your needs. If you are new to Web publishing, may we sug-
gest the following simplified internal structure for your site folder:

• index.html (the most common name for your Home Page)
• Media folder (to organize your images)
• Pages folder (to organize your additional Web pages)

Before we proceed to create our New Site, please close the open
document “untitled.html” within CyberStudio. There should no
longer be any blank document window visible.

1. Go to the File menu and choose New Site.
2. In the subsequent dialog box, navigate to the Tutorial Folder 

and name the site something like Tutorial.site.
3. Leave the Create New Folder checkbox selected to have GoLive 

CyberStudio create a new site folder. Click Save.
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4. GoLive CyberStudio will create a new folder named
Tutorial.site ƒ with the following content:
- The Tutorial.site.π site document: This is the document

that displays in the Site Window.
- The Tutorial.site folder: This is the folder where your 

pages and media are stored. Its content appears in the Files 
tab of the Site Window. When you create a new site, it 
already contains a blank homepage, titled index.html.

- The Tutorial.site.data folder: This folder is used to store
things that you need to build and maintain your site but 
that don’t need to be uploaded. For more details, please 
see the user manual, Chapter 16, Managing Web Sites with 
GoLive CyberStudio.

5. The Site Window appears, with a homepage already in place. 
It will look something like this:

6. You are now ready to begin designing a site. 

Let’s begin by adding some structure and files to our Web site.
Select the Media folder located inside your Web page assets
(tutorial) folder, and drag it from the Macintosh Finder into the
Site window pictured above.
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A simple drag-n-drop from the Macintosh Finder to inside
CyberStudio’s Site window is all it takes to automatically add
these images to your Web site!

Let’s continue by adding a new folder to our Web site. Select
New…Group from the Site menu.

A new “untitled folder” will appear in the Site window. Select this
folder and rename it “Pages.”
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Your Web site, all contained inside of the Tutorial.site folder on
your Macintosh, now consists of an index.html document, which
is the Home Page for your Web site, as well as two additional fold-
ers. The Media folder presently contains six separate image files.
The Pages folder is empty.

Let’s begin designing our first Web page by double-clicking to
open the index.html document listed in the Site window.

We suggest that you setup your screen to appear similar to the
picture below. You can also open the Color Palette which we will
introduce shortly by selecting it from the Window menu.
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Your first step will be to change the Title of our Web page — this
is the text that will appear in the title bar of a Web Browser 
application when your page is being viewed.

To change the Title, simply select the “Welcome to GoLive
CyberStudio” text next to the Page icon. Replace this text with a
new title, such as “What is Luakabop”.

One of the objects you’ll use often is the Layout grid (the second
object on the Palette). Once the grid is on your page, you can
place objects on it with one-pixel precision. The grid automatical-
ly expands to accommodate the size of the objects you place on
it. You can also make it larger yourself by selecting it and drag-
ging the appropriate handle.

You don’t have to use a Layout grid that runs the entire length of
the page. (Actually, using layout grids is optional on a page-by-
page basis; but it is much more convenient to do so.)

Let’s start by putting some text on the page:

1. Go to the Palette and locate the Layout grid icon.
2. Hold down the mouse button and drag the Layout grid icon to

your page (or double-click the icon in the Palette).
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Release the mouse button. The grid appears on your page as
shown on the previous page.

The grid can easily be resized by dragging the anchor points to
the desired size as illustrated above.

Now add text:
3. Go back to the Palette and locate the Layout Text icon.
4. Drag the Text Box icon onto your grid. Position it on the 

center of the grid as pictured on the following page.
5. To better position the text object (or any object), de-select it 

and move the cursor to any one of its edges. The cursor turns 
into a hand. Hold the mouse button down and drag the 
object box to where you want it.

Alternatively, you can select the object and move it one pixel at a
time by holding the Option key and pressing the Left, Right, Up,
or Down Arrow key.
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7. Type the following in the Layout Text box: “What is Luaka 
Bop?” 

Similar to a word processor, you can easily alter the text and
make “What is Luaka Bop?” bold, larger, and properly aligned.
Here’s how:

8. Select the text “What is Luaka Bop?” in the usual Mac way.
- Go to the Toolbar and choose Bold.
- Go to the Toolbar and choose Center alignment.
- Go to the Toolbar and select a font size of 6.
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To make your Web page more visually appealing, you can 
incorporate images into your design. Here’s how to insert them:
1. Go to the Palette and locate the Image icon.
2. Drag the icon to the left of the Layout Text box currently on 

the page as illustrated below.

3. Select the Image icon on your page.
4. With the Inspector window open, notice that it is context 

sensitive and now appears as the Image Inspector.
5. Select the Basic tab. The Source field will show “Empty 

Reference” because you have not yet selected the image to 
insert.

6. Select the Point and Shoot button and choose the Image you 
wish to have placed inside the Image icon. You do this by 
releasing the mouse button when the “anilogo.gif” small file 
icon and filename becomes highlighted in your Site window.
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Once you have successfully “Point and Shot” at the anilogo.gif, it
appears on your Web page, and the Image Inspector is updated
to indicate the relative path of the image. In this case, the 
anilogo.gif image is located inside of the Media folder.
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As with most other programs, GoLive CyberStudio does not auto-
matically save your work. It’s good practice to periodically do so
yourself and avoid potential data loss.

Save your index.html document.

Now that we have added a text and image object and saved our
work, let’s add color to what we already have. We’ll change the
colors of both the background and the text we’ve entered. Once
again, we’ll use drag & drop, but this time from the Color Palette,
which looks like this: 

The Color Palette has eight tabs with different color spaces; the
most often used of which is the browser-safe colors (selected); it’s
always wise to use the browser-safe colors that will keep your 
colors from dithering across platforms. These colors reside in the
sixth tab from the left (the one with the Roman numeral “I”).

To change your page’s background color:
1. Go to the Window menu and choose the Color Palette (if it 

isn’t opened).
2. Select the Page icon so that the Page Inspector is also opened.
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3. Go to the Color Palette and click on the Orange color labeled 
#FF9900. This color will appear on the Color Preview Pane in 
the upper part of the Color Palette.

4. With the mouse button up, move the cursor to the Color 
Preview Pane.

5. With the mouse button down, drag the color from the Color 
Preview Pane to the Background Color area in the Page 
Inspector.

6. Release the mouse button in the Background Color area so 
that the background color is in effect.

You may just as easily apply color to any selected text on your
Web page. Follow the steps above and drop the selected color
over the preselected (highlighted) text in the Layout View. 

Before we discuss how to create text and image links, we are
going to need to create two new pages for our Web site. Let’s do
this now, and then we will return to our index.html Home Page
to make links to the new pages.
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Let’s create our second Web page as follows:
1. Select New from the File menu and an empty page will 

appear.
2. Change the title of this page to, “What is Luaka Bop.”
3. Let’s save this page immediately by selecting Save from the 

File menu.
4. Name this document, “page2.html,” and be sure to 

save the page inside of the Pages folder we have created for 
our site.
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We’ve applied a background color to our Home page, but let’s
apply a background image to this second page. In order to do so,
we will need to select the small Page icon and open the Page
Inspector. 

How to apply a Background Image:
1. Place a checkmark in the Background Image area of the Page 

Inspector. An Empty Reference will appear since you have not 
yet selected your Background Image.

2. Select the Point and Shoot button in the Page Inspector and 
choose the Image you wish to have as the Background Image 
for your page. You do this by releasing the mouse button 
when the “bg2.jpg” small file icon and filename becomes 
highlighted in your Site window.
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The background image will now appear on your page, and the
relative path to the file is placed in the Background Image field of
the Page Inspector.

Please note that the Site window has added your “page2.html”
document to your Site window. This occurred automatically when
you saved the “page2.html” file inside of your Web site folder
structure. This is an example of the powerful Site Management
capability of CyberStudio 3 which is fully integrated with the
Macintosh Finder.

Let’s quickly add our third and final Web page by first navigating
to the Pages folder in our Site window, by double-clicking on the
Pages folder icon. Once you have navigated to the Pages inside
your Site window, add a Generic (blank) page to the folder. You
do this by selecting New… and Page from the Site window.

Name this generic page, “page3.html,” inside the Site window.
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You now have a three pages with varying amounts of content,
but as yet, there’s no way that a site visitor can get from one page
to the other. The next thing to do, therefore, is to add some links.

Here is how you create a link from selected text using Point &
Shoot. First, you will need to select the text that site visitors will
click on to go to another page:

1. Go to the Site Window, locate the index.html icon, and 
double-click. The page opens for editing.

2. In index.html, select “What is Luaka Bop?” so that it’s 
highlighted.

3. Select the New Link button in the Toolbar.

4. With the Inspector window open, notice that it is context 
sensitive and now appears as the Link Inspector.

5. Select the Point and Shoot button and choose the page you 
wish to link to.

6. Release the mouse button when the “page2.html” small page 
icon and the filename highlight. The interconnecting line 
blinks twice and the text is now displayed in blue and 
underlined. Furthermore, Pages/page2.html appears in the 
URL text box.
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7. You have just created your first hyperlink in GoLive
CyberStudio.

8. Go back to the source of the link, in this case the “What is 
Luaka Bop?” text, and Control-click to try out the new link.

9. The page2.html page opens on top of the other windows.

Unlike browsers, which open linked pages in the same window,
GoLive CyberStudio opens new pages in a new window.

In addition to linking from text, you can also link from a graphic.
Here’s how:

1. Select the graphic on index.html. The Inspector is now titled 
the Image Inspector.

2. In the Image Inspector, click the Link tab.
3. Select the New Link icon.
4. Locate the Point & Shoot button in the Image Inspector. It is 

located below the URL text box at the top of the main window 
area.

5. Click the Point & Shoot button and drag to the page3.html
page in the Site Window.

6. Release the mouse button when the “page3.html” small page
icon and the filename highlight. The interconnecting line blinks
twice andPages/page3.html appears in the URL text box.
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7. Go back to index.html. A blue border now appears around the
image to indicate that it is a clickable hyperlink.
8. Control-click the image.
9. The page3.html page will open in a separate window on top of
index.html.

You may find the blue border around the image annoying. Here
is how you remove it:
1. Click the image to select it.
2. Go to the Image Inspector and click the Special tab rider.
3. Locate the Border checkbox and text box combination.
4. Click the Border checkbox and make sure that “0” is entered in

the text box next to it.
5. This will remove the border around the image.
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Congratulations. You have just completed your first Web site
design. Now that the links are in place, you’ll want to test them.
You do that either with GoLive CyberStudio’s Preview mode or
with your browser.

To use GoLive CyberStudio’s Preview mode:
1. Open the page you want to preview—in this case, index.html.
2. In the document window, click the Layout Preview tab (the 

second from right, labeled Preview).
3. GoLive CyberStudio shows a preview of your page.
4. Go to the Inspector window, now titled Layout View Controller,

and locate the Root menu.

5. Select an option from the Root menu, for example Explorer 4
(Windows), to see how your page displays in Internet Explorer 4
on a Windows platform. Switch between the menu options and
observe how your page changes in Preview mode.

You will notice that the text “grows” whenever you switch to a
Windows-based browser. This feature shows the vast differences
between browsers and platforms — a fact you should keep in
mind when designing your pages. Because browsers and 
platforms all do things their own ways, a page that looks fine on
one system can look terrible on another. It’s always a good idea
to use the Root menu options in the Layout View Controller or,
better yet, try out your pages on as many different browsers and 
platforms as you can.
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To use a browser to preview your Web pages:

1. Go to the Edit menu and choose Preferences.

2. Select the Browsers icon (if it isn’t visible, scroll to it).
3. In the Browsers settings, you can click Add and then manually 

select the browser you want. Or you can click Find All and let 
GoLive CyberStudio automatically find all the browsers 
installed on your hard drive.

4. If you have more than one browser, click to select the check
box to the left of the one you wish to be the default. Click OK.

5. Close the Preferences dialog box to return to your page.
6. Locate and click the Show in Browser icon at the extreme right 

of the toolbar. (The icon varies with each browser.) Your 
browser will launch and display your page.

7. Note that all browsers installed on your system are also acces
sible from the toolbar popdown menu as shown below.
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GoLive CyberStudio provides you with a visual snapshot of your
Web site, so you can view how your three pages will be related.

To view your Site Map:
1. Select the Site tab rider in your Site Window.
2. Your Web pages will appear with a graphical representation of

the link hierarchy of your site — beginning with your 
“index.html,” or Home Page.

3. Open the Site View controller by selecting the special “eye” 
viewer button shown above.

4. The Site View controller window allows you to review your site 
map with various options available for viewing purposes.

GoLive CyberStudio’s Link Inspector allows you to review all
incoming and outgoing links and embedded items, such as
images, assigned to a given Web document.

By highlighting the index.html page in your Site Window and
selecting the Link Inspector button, you are able to view all links
and embedded images assigned to your Home Page.
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Once you’ve created your Web pages, linked them together into a
coherent structure and completed your site, it’s time to upload
the files to a Web Server so they may be viewed on the World
Wide Web.

FTP (File Transfer Protocol) is the medium for transferring files
between computers on the World Wide Web. Typically, an FTP ses-
sion involves a client and a server. If you have already signed up
with an Internet Service Provider, they may have created a per-
sonal FTP account and given you an FTP address, a user ID, a
password, and the path to your personal directory (optional). You
need this information to access their server and upload your site
after you are finished with your design, so they can post it on
their Web server. If you are not sure, ask the server administrator
for information on your FTP account.

GoLive CyberStudio features an easy-to-use FTP client with drag &
drop capability that is integrated into the Site Window. Before
using FTP, you need to make several settings, including the FTP
address, the target directory, your user ID and password, and vari-
ous communication-related settings:

1. Make sure that you have all communications-related control
panels (PPP, TCP/IP and Modem) set up properly on your 
Macin-tosh. For more details, please consult the user manual 
of your modem or ISDN adapter.

2. With the Site Window in the front, click the Site Settings but
not in the Site Toolbar.

3. The Site Settings dialog box appears (see next page).
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4. In the left section of the dialog box, click the FTP icon.
5. In the Server text box, type in the FTP address specified by 

your ISP for the Web server you wish to upload to.
6. If required, type in the directory path to your personal folder 

on the Web server in the Directory text box.
7. In the Username text box, type in the user ID given to you by 

the server administrator.
8. In the Password text box, type in the personal password given 

to you by the server administrator.
9. Place the cursor in the Port text box and type in the number 

of the port you will use to access your Web server, for example 
“21”, which is the most common port specification.

10.If a firewall protects the FTP server, you may have to check 
the Use passive mode checkbox.

Now that you have made the basic settings, you can connect to
the FTP server:
1. If the Site Window displays a single-pane only, click the FTP 

icon in the icon bar at the upper right corner of the window 
to display the FTP tab in the right pane.

If the Site Window displays two panes, click the vertical tab rider
labeled FTP in the right pane (if not already open).

GoLive CyberStudio Tutorial 28

Establishing Your Server
Connection



2. Click the FTP Server Connect/Disconnect button in the Site
Toolbar to access the server.

3. GoLive CyberStudio starts connecting to the FTP server. Wait 
for the Connected message to appear in the status line at the 
bottom of the FTP tab.

4. Click Upload to Server and CyberStudio will begin to send only 
those files that are new or have changed since your last 
upload session.

5. This is all you need to do to upload files to your ISPs server. 
6. When you are done copying, click the FTP Server 

Connect/Disconnect button in the Site Toolbar one more time 
to terminate the FTP session.

Now that you have learned how to upload a new Web site, lets
discuss how you can import an existing Web site structure for the
very first time.

Let us assume we had
already created a Web
site, and downloaded it
completely from our
Web Server to work on 
it in CyberStudio for 
the very first time.

GoLive CyberStudio Tutorial 29

Importing Your Web
Site into CyberStudio

Uploading Your Site to
Your Web Server



The name of this folder containing our entire Web site is:
Luaka bop site (Import tutorial)

Here is how you can import an existing Web site:
1. Make sure the folder structure of your Web site on your local
drive is identical to that of your Web Server. Otherwise, your links
will be broken throughout the site.
2. Select Import Site Folder… from the File menu.

3. Select the topmost Browse… button and locate the Luaka bop
site Folder in the dialogue window below.

4. Select the Luakabop site (import Tutorial) folder and press
Return.
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Notice that CyberStudio has already anticipated that the Home
Page for this site would be located in the root folder level and
include the usual filename, “index.html.”

5. Select Import to contine and load the entire Web site into a
new CyberStudio Site Window.

All Site documents are loaded into a new Site Window.
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Now that you have successfully imported your Web site, you may
begin working.

In this Tutorial section, you’ve completed the following tasks:
• created your first Web pages
• added content, including text and images
• added new pages and created a site document
• made links between pages
• previewed your work
• designed a site
• looked at an outline of your site structure, including link view
• uploaded files via an FTP connection
• imported a pre-existing Web site

There’s much more to know about Web design, of course, and
you may want to read one of the many books on the subject.
David Siegal’s Creating Killer Web Sites: The Art of Third Generation
Site Design (Hayden Books, 1996) is a good place to start.

We encourage you to visit our Web site at www.golive.com to learn
more about GoLive CyberStudio and obtain further tutorial 
material including Guided QuickTime Tours, Frequently-Asked-
Questions section, CyberStudioTalk Digest, Web Designer’s Toolkit
Reference Section, and much, much more.

Special thanks to Funny Garbage, Inc. for granting us permission
to reprint and distribute their material. Please note that we have
edited their material heavily for purposes of this tutorial. The
actual Luaka Bop Web site can be found at www.luakabop.com.

For further information about Funny Garbage, please visit their
Web site at www.funnygarbage.com.
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Summing Up


